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Web Studio 4.0 Service Pack 4 Release Notes 
We at Back to the Beach Software are excited to release the fourth service pack release 
for Web Studio 4.0. This release includes some really great new features, enhancements, 
and bug fixes. This service pack continues our commitment to providing additional value 
and continual improvement for our existing customers.   
 

What is Web Studio 4.0 Service Pack 4 
 
Service packs are the means by which Web Studio 4.0 updates are distributed.  

Service packs keep the product current, and extend and update its functionality. Service 
packs may include new features, feature enhancements, fixes, and additional 
components. All are conveniently bundled for easy downloading. Service packs are 
cumulative -- each new service pack contains all the features and fixes in previous 
service packs.. 

Please note that this document contains descriptions of Service Pack 4, as well as Service 
Packs 3, 2 and 1.  

Who Should Download Service Pack 4? 

Check the version of your Web Studio 4.0 program by opening the program; choose a 
New Website when the opening dialog comes up. Then choose Web Studio Version Info 
from the Help menu. The dialog that appears indicates the version at its top. If your 
dialog doesn’t say “Service Pack 4”, you should download and install Service Pack 4. If 
you already have Service Pack 4 or greater, it will be indicated in the dialog. 

To download and install Service Pack 4, go to the Resources Menu of the 
WebStudio.com website and choose Downloads. Once on the Downloads page, click on 
the Link to download Service Pack 4. Open or Run the download when asked. The file 
will then be downloaded to your computer and the Installer will start. Follow the 
instructions in the installer to install the Service Pack. Note that the installer will find the 
location of Web Studio 4.0 and will offer that location as the place to install. Accept that 
location by pressing the Next button and proceeding with the install. Installing Service 
Pack 4 will not delete any of your files. 
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Service Pack 4: New Features 
 
Summary of Major New Features 

 
• PayPal Shopping Cart for selling products online 
 
• New Slide Shows using Flash 

 
• New Text Effects using Flash 

 
• Full compatibility with Internet Explorer 7.0 
 
Using the PayPal Shopping Cart 
The complete documentation for PayPal usage is in the Help menu in Web Studio 
under the heading “PayPal Documentation”.  You can also get the documentation by 
simply dragging a PayPal button from the CoolStuff gallery and clicking the Help 
button in the resulting dialog.   
 
Suffice it to say, adding a PayPal shopping cart to your site is just a drag and drop 
affair.  
 
Slide Shows 
The complete documentation for the Flash based Slide Shows is in the Web Studio 
Documentation. You can view it from the Help menu in Web Studio under “Web 
Studio Documentation”.   
 
These new slide shows replace the older Java based slide shows. They also reflect 
feedback from customers relative to the type of slide shows suitable for business 
websites.  
 
Note that any slide shows on your current site will continue to work.  If you want to 
replace the old with the new, just delete the old one and drag a new one from the 
CoolStuff gallery. 
 
Text Effects 
The complete documentation for the Flash based Text Effects is in the Web Studio 
Documentation. You can view it from the Help menu in Web Studio under “Web 
Studio Documentation.”   
 
These new text effects replace the older Java based text effects. They also reflect 
feedback from customers relative to the type of text effects suitable for business 
websites. The old “childish” effects are gone.   
 
Note that any text effects on your current site will continue to work.  If you want to 
replace the old with the new, just delete the old one and drag a new one from the 
CoolStuff gallery. 
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Other New Features and Enhancements 
• Size Sensitive Galleries: The galleries have been enhanced to identify large 

photos and graphics and to offer the Graphic Resize dialog to enable you to 
quickly resize graphics added to the galleries. This resizes and resamples the 
graphics to suit the requirements of the web.  

 
• Internet Explorer Compatibility: No more crashing with IE 7.0. No more link 

problems with IE 7.0.  Microsoft came through on this one for all of us. They did 
a great job of finding their bugs that caused problems in WebStudio and fixed 
them. 

 
• Transparent Flash: All Flash objects will be transparent if they don’t have a 

background color assigned to them.  
 
• Centering Sites: Centering of sites is now turned on automatically for all new 

websites. If you want it for your existing site, go to the Website menu, to Website 
Properties and check the Centering check box at the bottom. 

 
• Centering Sites and Macs: The centering of sites now works correctly on 

Macintosh browsers. And an addition for those who write code -- the centering 
DIV now has its own ID. It is “CTRDIV”. 

 
• Buttons are Looking Great: SP4 removes the little dots that sometimes showed 

up in buttons. This should work for both old and new buttons. Just re-upload your 
pages to fix them on your site. 

 
• Registry Cleaning and Un-Registering or Crashing WebStudio: Software that 

“cleans” your computer can go overboard from time to time. We’ve taken 
additional precautions to keep these utilities from crashing WebStudio and from 
un-registering WebStudio. 

 
• Movies and Video: Quicktime movies now play better. Windows Media Player 

now plays movies better. 
 

• ALT Tags: ALT tags are used to display text about a graphic. Web Studio now 
provides ALT tags for all types of graphic content on a site. You can add text 
describing the content of the graphics by right clicking on the graphic object, 
choose Properties, click on the Graphic tab and then typing text into the Alternate 
Text field. The use of this feature can also assist in getting better rankings in 
search engines. And it also eliminates “errors” with some HTML code valuators. 

 
• Quickly Hide and Show the Galleries and PageList: Press ALT-H to hide both 

the galleries and PageList, both at once. Press ALT-G to quickly show both the 
galleries and PageList. We chose “G” because it was right next to H, in case you 
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forget which one shows them. Use this when previewing to quickly see how your 
site looks with a full screen and to rapidly return your desktop when you’re done. 

 
• Flash Objects Unstuck: Some Flash objects would end up above the top of the 

page and therefore become “stuck”. No matter what you did, you couldn’t move 
them down with the mouse. The Flash Object is now quite a bit smarter about 
such things and won’t let it happen. 

 
• Paste your Objects, Stay Selected: Objects pasted from one page to another now 

remain selected on the new page. This helps you manipulate the objects once they 
are on the new page. 

 
• Clipboard Clearing: Clicking on a gallery item used to clear the clipboard. This 

no longer happens. The symptoms used to be clicking on anything in, or dragging 
from, a gallery would result in the graphic being on the clipboard, or nothing on 
the clipboard if a non-graphic item was dragged. This was a pain for adding 
HTML to the HTML object. Because if you copied the HTML and then dragged 
the HTML object from the gallery, the HTML you copied was cleared. Now it 
remains on the clipboard and is pasted, it greatly smoothes these operations. 

 
• Text Turned To Graphics: If you added a text object to a page using the Text 

Gallery and the font you chose was a “red” or ‘yellow” font, you change the font 
to something else, but WebStudio would continue to thing it had its original “red” 
or “yellow” font. The result of this was that the text object was always turned into 
a graphic on the web. The text object is now well aware of where it came from 
and what it currently has and doesn’t convert itself to a graphic unless it should. 

 
• Page Files: You can now double click on a Web Studio Page file (.ova) and it will 

run WebStudio and use that page as the first page in the new site. Or, if you 
already have a site open, it will add that page to the site. 

 
• Target Page Size: the Target Monitor Size from the Website Properties dialog 

wasn’t being saved with the Project. It does now. 
 

• ASPX Files Supported: You can use asp.net with WebStudio. The File Type tabs 
in the Page Properties dialog now let you change the page’s file type to ASP.Net 
(.aspx). 

 
• HTML Emails: You won’t have any problems if your HTML email page is also 

your home page in the site. This used to cause some problems. 
 

• Project File Names Changing:  On occasion, Windows would rename your 
Project file by eliminating some of the letters and replacing them with a tilda “~”. 
That won’t happen any more. 

 
• Link Categories Can be Deleted: User added link categories can be deleted now. 
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• iHostStudio Selection is Un-Stuck: Choosing “Use another host…” from the 

Webhosting menu would sometimes not work and the setting would remain 
“stuck” on “Use iHostStudio…”. 

 
• Inserting Sound and Video: Choosing “Insert Sound File…” or “Insert Video 

File…” from the Insert Menu would do nothing sometimes. They always work 
now. 
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Service Pack 3: New Features 
 

Summary of Major New Features 
• Support for Limited Users 
• Create HTML Emails 
• Center Pages in Browsers 
• Center Objects Vertically 
• Attach Files to a Website 
• Change All File Types in a  Site 
• Convert Protected Graphics to Normal Graphics 
• And more… 

 

Using Web Studio with Multiple and Limited Users 
Web Studio 4.0 has built in support for Windows XP’s Limited Users. Limited Users are 
those users of a computer who do not have the ability to make changes that would harm the 
computer.  
 
Today, more than eighty percent of computer users in schools and in homes share their 
computer with other people. When multiple users share a Windows computer, multiple 
accounts can be created where each user logs in with his or her own account to access the 
computer. Normally, these user accounts are Limited User accounts that do not have 
complete control over the system. Administrator accounts typically have total and 
unrestricted access to every part of the computer. This can effect how Web Studio and 
other applications access file and registry information. 

 
Administrators of the system use highly privileged Administrator accounts through which 
they are allowed to make significant changes to the system itself, such as installing and 
removing key software components. And Limited Users have accounts that grant them the 
ability to run many programs on the system, but are restricted from making deep changes. 
 
Windows XP calls these non-administrative accounts Limited. Limited User accounts are 
used in schools, business, and homes. It keeps the kids (and employees) from “messing 
around” with the system and “breaking” it. 
 

How to Add a Limited User 
Limited users are added to the computer via the Users Account Control Panel. To add a 
Limited User: 
 

• Click on the Start menu in Windows XP; 
• Choose Control Panels from the Start menu; 
• Double click on the User Accounts icon in the Control Panels window; 
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• Click Create a New Account in the User Accounts window; 
• Type in a name for the new user account; 
• Click the Next button; 
• Choose an account type by clicking in the Computer Administrator or Limited 

radio buttons. To create a Limited User account, click the Limited radio button; 
• Click Create Account. 

 
The newly created account will be displayed in the opening Windows screen. Click on 
the user’s icon to log onto the computer with that account. 
 

Initially Running Web Studio as a Limited User  
The first time you run Web Studio as a limited user, the program will create a new Web 
Studio account for you. This may take some time.  What it is doing is copying files from 
the Administrator’s Web Studio and placing them in your account. You don’t need to 
worry about what is happening or what files are being copied. Web Studio knows what to 
do, and what files to let you modify. Just wait for it to complete and the program will 
start. 

 

Limited User Restrictions 
Web Studio 4.0 Service Pack 3 supports Limited Users. Here is a list of the 
differences and restrictions a Limited User account has with Web Studio. 
 

• They cannot add, delete or otherwise modify content in the Backgrounds, Buttons, 
Dividers, Signs, Clipart, Photos or Templates galleries. 

 
• They can add, delete and modify content in the MultiMedia, Links, and MyStuff 

galleries. 
 

• They cannot install content using the Insert Menu’s Insert Content from 
WebStudio.com command. 

 
• They cannot save or open Project documents or other files unless they are in their 

MyDocuments folder or in the computer’s Shared Folder. 
 

• The Add This Page to Templates Gallery command in the PageList menu is 
disabled. 

 
• The Gallery’s right click menu is not available for the Backgrounds, Buttons, 

Dividers, Signs, Clipart, Photos or Templates galleries. 
 

• Each Limited user has his own unique MultiMedia, Links, and MyStuff galleries 
that are not available to any other user.  
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• Each Limited User shares the Backgrounds, Buttons, Dividers, Signs, Clipart, 
Photos or Templates galleries as set up by the computer’s Administrator.  

 
• Each Limited User has his own unique User Dictionary for use with the Spell 

Checker command in the Format menu. 
 

Administrator Actions with Web Studio 4.0 Service Pack 3 
Any user with an Administrator account can act as the Administrator with Web Studio. 
Here are the things specific to Web Studio that the Administrator can do: 
 

• The Administrator can install, modify, repair, and uninstall Web Studio and Web 
Studio Upgrades. 

 
• He can add, delete or otherwise modify content in the Backgrounds, Buttons, 

Signs, Clipart, Photos or Templates galleries. These changes will be seen and be 
available to all users of Web Studio on the computer including both Limited and 
Administrator users. 

 
• The Administrator can add or delete Templates to the Templates Gallery. 

 
• In short, the Administrator can do all of the things that the Limited user cannot 

do, as previously described. 
 

Creating HTML Emails with Web Studio 4.0 
Everyone has seen HTLM emails. The monthly Web Studio Newsletter is an HTML 
email. Most emails that are advertisements are sent as HTML email. Sending email as an 
HTML email enables you to design a visually appealing email instead of just a bunch of 
boring text. 
 

How Do I Create an HTML EMail 
To create one you simply design a web page in Web Studio and then choose the Save 
Page as HTML Email from the Page menu. The page you create becomes the email, 
simple! 
  

What can I put in an HTML Email 
You can add anything you want to an HTML Email you create with Web Studio. You can 
add text, links, graphics, movies, music, Flash, downloadable files, rollover buttons, 
anything! 
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What Restrictions do HTML Emails Have 
The only restriction is that an HTML Email has to be one page. However, there are some 
practical restrictions, like the width of the page and the size of all the files.  
 
The reason the page width is a “restriction” is because most emails are viewed at the 
default width of the email program used to view it in. Open an email in your email 
program and see how wide it is. You can also look at the Web Studio Newsletters, their 
width is around 760 pixels. We do this to keep it smaller than an 800 pixel wide monitor. 
 
The reason the size of the files matters, is that the person who receives the email will 
have to wait for all of the files to download from your website. So, treat the emails the 
same as you would your website’s pages, keep them below 100k. Note that you can 
check the combined size of the files by choosing Size & Download Time from the Page 
Properties dialog in the Page menu. 
 

What Can I Use HTML Emails For 
You can use them to “spruce” up your normal emails. You can use them as 
advertisements. You can create a monthly newsletter. You can use them to quickly send 
pictures of the kids to relatives. You can use them to quickly send pictures and 
descriptions of your products to customers. You can use existing pages on your website 
as HTML Emails by simply saving a page from your site as an HTML Email and then 
sending it to whomever.  
 

How do I Create an HTML Email in Web Studio 
 
First you should have an idea of what Web Studio does to create the HTML Email for 
you. First, the HTML Email is nothing more than a webpage that is sent via email. When 
you create your website with Web Studio, you have to Upload it to your hosting company 
for people to see it on the web. You also have to upload the HTML Email’s files to your 
hosting company. The big difference between your site and the email is that you don’t 
send the actual HTML files to the hosting company, just the other files; like graphics, 
MP3 files, videos, etc. The HTML file doesn’t need to be uploaded. Why? Because you 
are sending the HTML directly to the email recipient!  

 
What all of this means is that it is a multi-step process to create your HTML Email in 
Web Studio. However, you will see these steps are baby-steps, not giant-steps. 
 

Here are the steps to create your HTML Email 
 

• Create a page in Web Studio, add whatever you want to it. 
• Choose Save Page as an HTML Email from the Page menu. 
• Enter the complete URL to your home page. 
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• Save the HTML file to your hard drive. This file is the one you actually use in 
your email. 

• Upload your page to your site. 
• Open the HTML file and add the contents to your email program.  
• Send the email. 

 
Web Studio automates every step except adding the HTML to your email. 
 

• Once you choose Save Page as an HTML Email you’ll be prompted by Web 
Studio for the URL to your website. This is what you’d type to get to your home 
page. For us, it would be http://www.webstudio.com  

 
• You next be prompted to enter the location to save the HTML file, just put it in a 

folder in your MyDocuments folder.  
 

• It will then bring up the Web Studio or iHostStudio Publisher wizard to upload 
your page. Just upload it as normal. 

 
• That is the end of creating the email. 

 
• Now you just open the file you saved in Notepad and copy and paste the HTML 

into your email, or you follow your email programs’ instructions for creating an 
HTML email.  

For our monthly Newsletter: 
• We just create the new newsletter; 
• choose Save Page as an HTML Email; 
• Enter http://www.webstudio.com; 
• Enter the name for the HTML file, usually something like Vol4No2; 
• Click Upload in the Web Studio Publisher; 
• Then go to our bulk-email program and tell it to use the Vol4No2 file as the mail.  
• Then we press the Send button. 

 

Some Hints on Using the Save Page as HTML Email Feature 
Create one project that you keep all of your newsletters in. You name the project 
“Newsletters” and then create your first newsletter as the first page of the project. Once 
you’ve completed it, save it as an HTML Email and send it out.  
 
Next time you need to create a newsletter, just open the project and duplicate the first 
page. Edit this new page to create your new newsletter. Rename the page and then save it 
as an HTML Email. This way you have all of your newsletters in one project, have 
immediate access to them for editing, simplify the creation of new ones via the duplicate 
command. 
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Use existing pages in your web site to send to customers as an email. Just open your 
website’s project file, go to the page you want to send to the customer and save it as an 
HTML Email. 
 
Create a project that has the answers to various frequently asked customer support 
questions. Remember, you can add multimedia to your emails now, so you can create 
movies, animations, flash animations to illustrate the answer to the question. 
 
If you re-use a page as an HTML Email, as suggested above, you may not have to re-
upload every time you send it out as an email, just click Cancel when the WebStudio or 
iHostStudio Publisher wizards appear. The reason you don’t have to upload is because 
you already did, the last time you sent it. You can make changes to text and the location 
of objects and not have to re-upload. Note, however, that if you make any changes like 
bring to front or send to back, or add additional objects to the page you should definitely 
re-upload the page, if you don’t it won’t look right as an email. 
 
Send the email you’ve created to yourself to check it to make sure it is the way you want 
it. You should do this every time you create an HTML Email! 
 
Centering Your Pages in Browsers 
Many people have asked for a way to center their pages in the browser, no matter what 
size the browser window is. This is because a site designed to fit in a smaller window 
would have the site’s pages on the left side of the browser with blank space on the right 
side. Turning on this feature will center the pages in the website in the browser window. 
Note that this sites that use Frames will not be centered. 
 
To center the pages of your site: 

• Choose Website Properties from the Web Site menu. 
• Click the Advanced Tab in the dialog. 
• Click the Center Pages in Browser check box to put a check in the box. 
• Click OK. 
• Choose Preview Website from the Preview menu to view your pages centered in 

the Preview window’s browser. 
 

Centering Objects Vertically 
Studio has been able to center objects horizontally for quite a while. It can now center 
them vertically. This comes in handy, for example, when you want to center a graphic 
and some text that are beside each other.  
  

• To center objects vertically: 
• Select the first object as the basis for the centering; 
• Select another object by holding down the shift key and clicking on it; 
• Select any additional objects in the same fashion. 
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• Choose Center Selected Objects Vertically from the Objects menu or Click the 
Center Selected Objects Vertically button in the Layout Toolbar. 

The Objects will center themselves relative to the first object selected. 
 
Attaching Files to a Website 
Web Studio can now automatically upload any file(s) you want along with your website. 
This comes in handy when you are using other programs with Web Studio, for example a 
pop up menu program. These programs typically require you to upload some number of 
JavaScript files and other files in order for the menus to work.  Previously, you would 
have to upload these files via a separate FTP program, or add them to an HTML object on 
a page and then link the menus to that page.  This made for a cumbersome and confusing 
task of adding the menus. 
With Service Pack 3, you can simply go to the Website Properties dialog, in the Website 
menu, click on the Attached Files tab and add any files you need. The files will be 
uploaded when you upload your site or a page. They will be uploaded in the same 
location (or folder) as the HTML files in your site.  

Attaching Files to a Website 
• To attach files to a website: 
• Choose Website Properties from the Website menu. 
• Click on the Attached Files tab. 
• Click on the Add Files to List button, the Windows Open dialog comes up. 
• Choose the files to be added to the website. You can hold down the Shift key to 

select multiple files or hold down the CTRL key to select multiple files that are 
dis-continuous. 

• Press Open when the files have been selected. 
• You can attach additional files from other locations by repeating this procedure. 
• You can Delete any attached files by selecting them in the Attach Files tab and 

clicking the Delete button. Note that this does not delete the actual file, it just 
removes it from the lists of attached files for this website. 

• You can use the Verify button to have Web Studio check to see if the attached 
files are still available in the same location on your computer. 

Linking to Attached Files from within Web Studio or other programs 
Any files attached to a site are uploaded into the site folder along with all of the 
site’s HTML files. This means any links to an attached file can simply be the 
file’s name. For example, if a file were named “Menus.js”, any HTML or 
Javascript or Link that referenced that file would simply use “Menus.js” as the 
link. Simple!  

 
Changing File Types for All Files in a Site 
Web Studio 4.0 added the ability to specify what file type you wanted to build on a page-
by-page basis. This feature enables you to change every page’s file type for both “on the 
web” and for “preview”. 
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To change the type of files for all pages: 

• Go to the Web Site menu; 
• Choose Website Properties; 
• Click on the File Types tab; 
• Choose the file type for Pages on the Web from the popup menu. 
• Choose the file type for pages that are Previewed from the popup menu. 
• Click OK. 

 
Web Studio will then go through your pages and change their file types. 
Converting Protected Graphics to Normal Graphics 

Sometimes it is desirable to convert a Protected Graphic object to a normal graphic. Service 
Pack 3 adds a “hot-key” feature that will do this for you. You can convert a single 
protected graphic or a series of protected graphics all at once. 
 

Converting a Protected Graphic to a Normal Graphic 
 

• Click on the Protected Graphic to be converted. 
• Press and hold down the “g” key on the keyboard. 
• Click on the Protected Graphic to be converted. 

 
A new, normal, graphic will be created and placed on the page to the right and below the 
original protected graphic. 
If you wish to delete the original protected graphic, press the Delete key or choose Clear 
from the Edit menu. 
 

Converting a series of Protected Graphics to Normal Graphics 
• first Protected Graphic to be converted. 
• Press and hold down the Shift key and click on the remaining graphics to be 

converted while holding down the Shift key. 
• Once all of the graphics have been selected, release the Shift key. 
• Press and hold down the “g” key on the keyboard. 
• Click on any of the Protected Graphics to be changed. 

 
A new, normal, graphic will be created and placed on the page to the right and below each 
of the original protected graphics. 
If you wish to delete the original protected graphics, press the Delete key or choose Clear 
from the Edit menu. 
 

Converting all of the Protected Graphics on a Page to Normal 
Graphics 
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• Choose Select All from the Edit menu. 
• Press and hold down the “g” key on the keyboard. 
• Click on any of the Protected Graphics to be converted. 

 
A new, normal, graphic will be created and placed on the page to the right and below each 
of the original protected graphics. 
If you wish to delete the original protected graphics, press the Delete key or choose Clear 
from the Edit menu. 

Other New Features and Enhancements 
• Help with Lost Project Files: When Web Studio can’t find the Project file you 

are attempting to open, it will give an error dialog telling the name of the file, its 
last known location, and steps to take to locate the file. 

 
• Previewed Pages use .HTML: For new pages, the default file type for Previewed 

pages is now .html instead of .htm.  
 

• Moving Text in Netscape: The Netscape Text Fix has been removed from the 
Website Properties dialog’s Advanced Tab. It is no longer necessary since Web 
Studio now adds appropriate HTML to solve the problem automatically. This fix 
keeps text from moving in the Netscape family of browsers. These include 
Netscape Navigator,  FireFox, Mozilla. 

 
• Non-WebSafe Fonts Turned to Graphics: For new websites, text objects 

containing fonts that are color-coded yellow are converted to graphics by default. 
This can be changed in the Website Properties dialog’s Advanced Tab, and 
existing websites can be set to do this the same way.  

 
• Enhanced Video Choice Dialog: The Video Choice dialog disables some 

properties that aren’t available with Quicktime movies. 
 

• Page Guide Settings Saved: The on/off status of Page Guides is saved with the 
Project and with pages now. 

 
• Page Design Size Saved: The Page Design Size is now saved with the Project. 

 
• Home Page Name Help: Pages cannot be named “index.html” or “index.htm” or 

“index” anymore. To designate which page’s HTML file should be named 
“index”, place the House Icon next to your home page’s name in the PageList. Do 
this by right clicking on the page’s name in the PageList and choosing 
HomePage. Note that if your existing site has a home page named “index”, it will 
not be affected by these changes. Only pages that you attempt to rename will be 
subject to the new rules. If yours is named “index” you should rename it with a 
name that reflects your websites function, like your company name or product 
name. 
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• Illegal Characters in Page Names Excluded: You cannot enter a period, a single 
quote or a double quote in a page name now. This would cause problems with 
links and javascript. Note that your existing site will not be affected by these 
changes. Only pages that you attempt to rename will be subject to the new rules. 

 
• Enhanced HTML Object: The HTML object now remembers its “Build 

with/without Tags” option settings. 
 

• Time Zone Change: The HTML Source of your site’s pages will show the file’s 
creation time as Pacific Standard Time. This is to help tech support. 

 
• Help Changing Home Pages: A dialog is displayed asking for confirmation 

when you choose to change your Home Page. 
 

• Add Anchor to Object Enhancement: The Program Preferences dialog in the 
Edit menu now contains a check box to add the “Add Anchor to Object” 
command to the Links gallery. Some Windows systems delete the first item in the 
gallery, this preference forces Windows to put it there. If you already have “Add 
Anchor to Object” in the Links gallery, leave this unchecked. 

 
• Protected Graphics Enhancement: The “Place holder” graphic is now being 

resampled to  makes its memory requirements minimal. 
 

• The Title Tag in a page’s HTML is now the first tag in the HTML. 
 

• Spelling checker in the Format menu works fine. 
 

• The Download Time/Size page in the Page Properties dialog gives accurate 
results again. 

 
• Saving a Project with the Preview window open doesn’t delete text. 

 
• Adding templates to the Templates gallery works. 

 
• Real Video and Quicktime Video work better now. 

 
• The colors of Text Links weren’t displayed in Firefox, Mozilla, or Netscape. They 

are now. 
• A text object with the text file:/// in it won’t cause problems now. 

 
• Objects that had a zero height or width could cause a “failure to build image 

table error”. Web Studio now deletes these objects when a page is opened. 
 

• On occasion, the formatting of text would be “lost” when previewed or uploaded. 
Formatting isn’t lost anymore. 
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• Multimedia files, except for Flash files, were getting uploaded twice. Now they 

get uploaded only once. 
 

• Protected Graphics that were moved and then located again during a Preview This 
Page had their new locations remembered. However, if they were located during a 
Preview Web Site, their new locations were not remembered. Now they are. 

 
 

 
 
 

Service Pack 2: New Features 
 
The Button Studio and Editable Text in All Buttons 
 
Greatly simplify your site creation with editable text in buttons, any button. Any non-
rollover button dragged from the Button gallery now brings up the Button Studio dialog. 
This dialog enables you to add editable text to your buttons. You can also change the 
font, style, size, and color of the text. 
 
Once a button is on your page, just double clicking on it enables you to change the text or 
its font, style, size or color. 
 
Once a button is on your page, simply copy and paste it to create all the buttons you need 
for your page. Then double click on them to change their names to suit your needs.  
 
To use the Button Studio: 
 
Drag any graphic button from the Button Gallery and the Button Studio dialog will pop 
up asking you to enter the text to be used on the button. This dialog is similar to the 
Rollover Studio dialog. It lets you enter text; change its font, size, color, style; enables 
adding the flat, chiseled, raised text styles as well.. It also has a preview of the button.  
 
Enter your text, choose a font, style, size, and color if desired. Click the OK button and 
the resulting button is placed on the page.  
 
To edit the button’s text or its font, style, size of color, simply double click on it and the 
Button Studio will come up so you can change any of the properties of the button’s text. 
 
To create a suite of buttons for you page or site, just create the first one and then copy 
and paste as many others as you need. Then double click on each and change the button’s 
text to whatever you need. 
 



Web Studio 4.0 Service Pack 4  Page 17 
Copyright 2007, Back To The Beach Software, LLC 

The Button Studio is a long-over-due addition to Web Studio and will make it much 
easier for people to create their buttons, add whatever text they need for them, and add 
links to them. Gone are the days of adding a button to a page, creating a text object and 
adding the button’s text, drag it on top of the button, add a link to the text. And then, 
realizing (or in most cases not realizing) that the link is on the text but not on the button!  
------------------------------ 
HyperStudio Stack Compatibility  
 
HyperStudio is, it is the #1 best selling educational software of all time. It enables 
students, and anyone, to create “stacks” that are basically pages with multi-media content 
on them. If you’ve heard of SuperCard or HyperCard, they are the forerunners of 
HyperStudio . 
 
Web Studio is now the only web authoring program that has drag and drop (or any) 
support for HyperStudio. Web Studio support for HyperStudio is one of the most 
requested features from educators around the world! 
 
To add a HyperStudio Stack to a page: 
 
You add a HyperStudio Stack (file extension is .stk) by dragging and dropping in onto a 
page, or by choosing Insert>HyperStudio Stack from File.  
 
With either of these methods,  the stack file will be opened, its dimensions and other 
significant properties will be read by WebStudio and the HyperStudio object will be 
placed on the page.  
 
To view sites with HyperStudio Stacks: 
 
HyperStudio has a browser plug-in that must be in the computer of the person viewing 
the page, otherwise you get an error message.  The Plug-In is available at the 
HyperStudio website, www.hyperstudio.com. 
 
When you Preview a page or site that contains a HyperStudio stack, the preview will take 
place in your default browser, not in the Web Studio Preview window. This is because 
the HyperStudio Plug-In has a bug that crashes it if it is viewed in a browser embedded in 
another program. 
 
For more information about HyperStudio, go to http://www.hyperstudio.com. 
 
The Add/Edit Links dialog 
 
The Add/Edit Links dialog from Web Studio 4.0 SP1 has been replaced with a new hot-
rod version.  
 
It is a tabbed dialog containing two tabs: Links and Anchor. 
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The Links tab enables you to add new links to an object or selection of text as well as edit 
existing links in objects or text. You can add any of the available types of links with this 
dialog: Site links, Anchors, URLs, Downloads. 
 
To use the Add/Edit Link dialog: 
 
To activate the Add/Edit Links dialog, right click on an object or on a selection of text. 
 
If there is a link already in the object or selection, it will display all of the links properties 
in the dialog. If there is no link, each field in the dialog will be blank. 
 
You can enter the Title for the link; enter an optional description; choose to have the link 
open in a new window; or remove the link. 
 
In addition, you can create a “normal” link, defined as a URL to an external http site, ftp, 
mailto, etc. Or you can create a “download” link, where the link, when clicked, 
downloads a file or displays the contents of the file. Or you can create a “site link” to 
another page. Or you can create an “anchor” link that will, when clicked, take you to a 
previously defined anchor. 
 
To create an Email link: 
 
In the URL field, enter mailto: and then the complete email address. For example, 
mailto:support@webstudio.com will result in an email coming up when someone clicked 
on the link. 
 
To create an FTP link: 
 
In the URL field, enter ftp:// and then the address of the ftp site. For example, 
ftp://microsoft.com/myfile.doc would result in the  file “myfile.doc” being downloaded 
from the Microsoft site when clicked on. 
The Anchor Tab: 
 
The Anchor tab is another new addition to Web Studio. This tab tells you if you have an 
anchor on the object or selection. This would be the anchor you created when you 
dragged the “Add anchor to object” item from the Site Links list of the Links gallery. The 
anchor displayed here is not editable it is for informational purposes only. 
 
In previous versions you couldn’t tell if an object or text had an anchor, or what the 
anchor was. 
 
In summary, the new Add/Edit Link dialog makes it much easier, and smoother to add 
links directly to your objects and text. The “old way” of entering them in the MyLinks 
list (or user defined categories) is still there for creating links. The MyLinks method is 
very convenient and the preferred method when a link is to be used on multiple objects or 
on multiple pages.  



Web Studio 4.0 Service Pack 4  Page 19 
Copyright 2007, Back To The Beach Software, LLC 

 
Self-Healing Project Files 
 
Computers certainly aren’t perfect and a result of that is the dreaded corrupted file. 
 
Web Studio SP2 now has the ability to detect a corruption in one of its Project files and 
“heal” it while it is being opened. 
 
If a corrupted graphic is detected, an error dialog will appear notifying you that it was 
found. The corrupted graphic will then be replaced on the page being read with a gray 
place holder graphic. The error dialog tells you what page the corrupt graphic was on.   
 
If a page is somehow corrupted, Web Studio will read as much of the page as it can and 
then give a similar error message.   
 
In all cases, the Project fill will be opened and no “out of memory” errors, “unexpected 
format errors” or others will occur. 
 
There are some corruptions that WebStudio won’t be able to “heal”…those from serious 
hard disk corruption or other nasty physical problems. 
 

Other New Features and Enhancements 
 

Drag and Drop any file to make a Downloadable File Link 
 
You can now add any file as a download by pressing the “CTRL” key when dragging 
the file on to a page or an object. This allows creating Download links for files 
WebStudio knows how to open, like graphics, HMTL, Word files, etc. 
 
Simplify Uploading if you use another FTP program 
 
The contents of Preview folder do not get deleted when you Preview a page now. 
This enables you to Preview just the pages you wish to upload and then simply 
upload the previewed pages and their folders from the Preview folder all at once. 

 
The Clipboard is no longer cleared when WS starts. 
 
Web Studio 4.0 had a nasty habit of clearing the Windows clipboard when it started. 
It now leaves the contents of the clipboard alone when it starts up. 
 
Change Transparency and Colors Rapidly 
 
This “hot-key” combination enables you to quickly change the color depth and 
transparency of a selected graphic or graphics. Press and hold the Shift key and then 
the “2” key. The selected graphics will be converted to 256 colors, their transparency 
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color will be set to white, and transparency will be turned on. This is handy when you 
are inserting or dragging in lots of graphics files and want to change them all quickly. 

 
No More Lost Files when Building Your Site 
 
During Upload and Preview if a file is not found, a dialog will offer the following 
options: Cancel, Browse to find the file, Ignore the file, Ignore all missing files. 

 
Easily Use the Web Studio Template Gallery 
 
Template Gallery link added to the Help Menu to enable you to view and download 
templates from the Webstudio.com website. The downloaded templates are added to 
your site with the Page>OpenPage menu command. 

 
No More Corrupted MyLinks files 
 
Links in MyLinks and other user created categories will “self-heal” if they are 
corrupted. 

 
 

Fixed Bugs 
 

Text doesn’t move down in Netscape: there is now a setting in the 
Website>Properties>Advanced page that lets you turn on/off the “fix” for Netscape 
moving text down the page. For sites you’ve already “adjusted” for this Netscape 
problem, leave the setting “off”. With a site that has the problem, of for new sites, 
turn the setting “on”.  
 
Thin Graphics moving down the page: Graphics with heights < 16 pixels are 
moved down the page in Preview and on the web. There is a new setting in the 
Website>Properties>Advanced page that lets you turn on/off the fix for thin graphics. 
For sites you’ve already “adjusted” for this problem, leave the setting “off”. With a 
site that has the problem, of for new sites, turn the setting “on”.  
 
Changing Text Color Changes Size and Font: Change Color of text could reset the 
text’s size and font to default font and size. It now respects the original font and size 
when you change text colors. 
 
Text Background Colors Not Showing: Text not displaying specified background 
colors in Preview and on the web. The colors are now displayed correctly. 
 
Changing Text Color Didn’t Work: Attempting to changing the color of text 
characters that were selected didn't work Changing text color works for both selected 
text objects and selections of text now. 
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White Text Disappears: Changing text color to white could make the text disappear. 
It now uses an off-white color to make it show up on dark backgrounds. 
 
Text Objects Get Narrower: When opening a Project, text objects could get 
narrower. Text objects retain their width when opened now. 
 
Text Objects Get Deeper: When opening a Project, text objects could get deeper. 
Text objects retain their depth when opened now. 
 
Fully Justify Button Doesn’t Work: Full Justify button didn’t work on occasion. It 
now works in all cases. 
 
Can’t Justify Text: If text justification was modified when the text itself was 
selected, it couldn’t be justified any more. Text can be justified no matter what, now. 
 
 
Text Objects not Turning Into Graphics: Text with yellow or red fonts didn’t turn 
into graphic objects all the time. They do now. 
 
Graphic Text Objects Losing Links: Text objects lost their links when turned in to 
graphics. They retain their links now. 
 
Add/Edit Links Menu Item: Add/Edit Links menu item was enabled when objects 
that couldn’t have links were selected, like Flash. The menu item is enabled at the 
correct times now. 
 
Download Links not Uploading Files: Text Objects with Download links that are 
turned into graphics didn’t upload their files. Download links upload their files 
correctly now. 
 
Sounds in Text Objects not Working: Text Objects with Sound linked to text may 
not have operated correctly. They operate correctly now. 
 
Crash with Overlapping Text Objects: Text objects with links overlapping other 
objects when the Use Tables html option is on could crash during Preview (may take 
as many as 10 previews to crash it). The crash no longer occurs. 
  
Overlapping Objects Lose Links: Objects that overlapped with the Build With 
Tables option turned on would lose their links in Preview and on the web.   
 
Download Links Not Working: Download links didn’t work correctly at times if not 
applied to an object (dropped on the background). The work correctly now when on 
the background. 
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Previous Version’s Links being Lost: Conversion of WS 1.0, 2.0,3.0 documents 
deleted various links. Links on some graphics objects were getting discarded when 
the doc was opened. All links are preserved during conversion now. 
 
Text Object Border Drawing: The Text Object drew the “empty” rectangle when 
there was 0 or 1 character in it. Now it only draws if there is 0 characters. 
 
Paste In Place Command: CTRL-ALT-V will now do a Paste In Place, used to do 
just a Paste. 
 
Save As Command: Pressing F12 will bring up the Save As dialog to enable initially 
saving the project, or saving an existing project with a different name or to a different 
location. 
 
Losing Links with Page Name Change: Changing the name of a page resulted in the 
old name being used in page links. 
 
 
Page Objects Moving: Opening Page files (.ova) could cause some objects on the 
page to move. 
 
Nudging Too Far: It was possible to nudge objects above the page and to the left of 
the page with the arrow keys. This could cause objects to not appear in Preview and 
on the web. 
 
Squished Text in Rollover Buttons: Rollover button’s text was “squished” if the 
graphic it was made from was resized by not resampled. It is now displayed correctly. 
 
Cropping: Cropping would have a refresh problem if you let go of the “C” key prior 
to releasing the mouse button. The cropping-rectangle would also be “connected to 
the mouse until you clicked on the page somewhere. 
 
Percent Signs in File Names: File names that contained % signs caused problem in 
Preview and on the web. The % sign is now restricted from the 4.0 file name rules, it 
already was restricted in the 3.0 file name rules. Note that you can use % in the name 
of your page. 
 
Animated GIFs in Slide Shows: Slide show causes an error if one attempts to add an 
Animated GIF to the slide show. A warning is displayed now if an Animated GIF is 
added to a slide show and the Animation is not added to slide show. 
 
Welcome Dialog Spelling: Spelling in the Welcome dialog corrected. 
 
AutoBackup Feature not Working: Saving project with AutoBackup feature failed 
if the folder didn’t exist, it now creates the folder if required. 
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Page Commands Not Working: Page related commands in the Page Menu didn’t 
work if the PageList wasn’t visible. The appropriate commands work now with the 
PageList visible or not. 
 
Rollover Button’s Text Color: Text color in Rollover buttons wasn’t always what 
was chosen. It is now. 
 
Misleading Error Dialog: Deleting a user-created folder in a gallery popped up a 
dialog that implied the deleted files could be re-downloaded from the Webstudio.com 
website. The text has been corrected. 
 
Animated Rollover Buttons: The Animate button in the Rollover studio dialog 
seemed to, at times, have no effect on the button. It does now.  
 
Status Bar Flash Help: The status bar help was incorrect when a Flash object was 
selected. It has been corrected. 
 
 
Quicktime Videos Not Working: Quicktime files weren’t supported correctly in the 
Insert>Video file function. They play correctly now. 
 
Sound File Types: The sound types supported in the Insert menu were different than 
in the Multimedia gallery. They are the same now. 
 
Sound Dialog Arrows: The arrows to adjust the number of times a file is played in 
the Add/Edit Sound dialog worked in reverse. It now works properly. 
 
Status Bar Help for Text: Status bar help for selected text objects was cut off. The 
text has been corrected. 
 
Menu Names: Some menu names were not consistent in their spelling. The names 
have been corrected. 

 

Web Studio 4.0 Service Pack 1  

The information about Service Pack 1 is included here to ensure all of the 
changes to 4.0 are communicated with Service Pack 2. 

Service Pack 1 is included in Service Pack 2. When you download and install Service Pack 2 you are also 
installing Service Pack 1.   

If you’ve already installed Service Pack 1, installing Service Pack 2 will not cause any problems. The two 
are compatible with each other. 

New and Enhanced Features 
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Text Anchors 
 
Anchors can now be added to selections of text.  

All previous Web Studio versions allowed anchors to be added only to objects. With the new functionality, 
you can select text in a text object and add an anchor to it, just like you would add a link, or a text style. 
The result is that you can now use anchors in text to allow visitors to your site to click on buttons or other 
links that will scroll the web page to a specific location on the page. For example, you could create a table 
of contents for a page with links that pointed to each major section of the text on the page. The old type of 
anchor only allowed you to scroll to the top of an object, not to specific locations in it. Note links to Text 
Anchors can be used to take a visitor from one page to another in addition to a different location on the 
page the Text Anchor is located. 

To use the new Text Anchor feature: 

Select the text that is to be the anchor, 
 
Go to the Links gallery and drag the Add Anchor to Object item onto the selected text. The Anchor Dialog 
comes up.  
 
Enter a unique name for the anchor, and a description if you wish. The description will show up as a pop-
up when a visitor's mouse moves over any links to the anchor. 
 
Click OK. The anchor is immediately applied to the text, and a new Link is added to the Site Links list in 
the Links gallery. 
 
To create a link to a Text Anchor 

Create an anchor in text as described previously.  
 
Drag the Link with the Anchor's name from the Site Links List onto a button or other graphic or to a 
selection of text and drop it.  
 
The link to the Text Anchor is immediately applied. 
 
To delete a Text Anchor from the Site Links list 

Right click on the Anchor's name in the Site Links list. The SiteLinks menu pops up. 
 
Choose Delete from the menu and the Anchor is deleted.  

Note that any Text Anchors that already exist in your site will not be deleted and will remain fully 
functional. 

 
Enhanced Features 
 
Site Links do not show a Pop-Up Description when moused-over. 
 
Links to pages on your site that are added from the Site Links list in the Links Gallery will not show a Pop-
Up with the name of the Page. Previously it did and was considered redundant to show a Pop-Up when the 
mouse was over the text or button with the same name. For example, if the button with the link was named 
“Home”, and the link was to the page named “Home”, a Pop-Up with “Home” in it would popup right next 
to the button named “Home.”  
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MultiMedia Recognizes MPEG 
 
The MultiMedia's Video list will recognize MPG files that have the .mpeg file extension. Previously, MPG 
files with the .mpg file extension were the only ones recognized.  
 
Link Gallery Enhanced Feature 
 
If you add a new Link Category to the Link Gallery that has the name of an existing category you will get 
an error message. Previously the new category would not get added, and with no explanation.  
 
Add/Edit Link Enhanced Feature 
 
This feature of the Right Click menu is disabled if you are right clicking on a text object. To add or edit 
links in a text object, select the text with the link first and then right click on the selection and choose 
Add/Edit Link from the resulting menu.  
 
Fixes 
 
Spell Checker Fix 
 
Some very early versions of Web Studio 4.0 did not include the spell checker dictionaries. They are 
automatically installed with SP-1.  
 
Background Colors in Text Fix 
 
Background colors added to text objects would not work in certain cased. In addition, making a text 
object's background transparent wouldn't work if it already had one. Also, when you change a background 
color in a text object, it will take effect immediately.  
 
Locked Text Object Fix 
 
Text Objects that were locked using the Object Properties dialog, could cause problems when the Project 
they were in was opened. It was also possible to corrupt Project files this way.  
 
MyLinks Fix 
 
Under certain conditions, links added to the MyLinks list, via the Add/Edit Link dialog, and added to user 
added lists would link to a folder on your computer.  
 
Anchors Fix 
 
Under certain conditions, anchors that were created in previous versions of Web Studio would be deleted 
or otherwise corrupted when opened in Web Studio 4.0.  
 
Add/Edit Links Fix 
 
Right Clicking on an object or a selection of text and choosing Add/Edit Link could delete an existing link 
if Cancel was pressed in the Add/Edit Link dialog. Once Cancel was pressed, the link's data was deleted 
and resulted in a blank link. This was also a possible source of Project file corruption.  
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